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About this document

 

This document describes the operations controller (OPC) tools and procedures 
used in the administration of data for both the OPC and the network elements 
(NE) in an AccessNode.

The OPC procedures in this document (although CMT-based) can be 
performed from a graphical terminal. However, you must substitute the CMT 
keystrokes that are provided in the procedures with the graphical equivalent. 

For basic procedures, and mouse and keystroke information, see the Graphical 
Reference card in the sleeve of this volume. In addition, commands, 
parameters, and response conventions used in OPC procedures and in 
procedures for the network element user interface are included in 

 

Network 
Element User Interface Description

 

, 323-3001-300, and 

 

OPC User Interface 
Description

 

, 323-3001-301, in this volume.

 

How to use this document 

 

Look up the task, as it relates to your job, in the left column on the following 
table. Then refer to the page as indicated in the right column. 

 

Common and occasional tasks See

 

Managing network element database backups from NE to OPC page 1-1

Backing up files to and restoring from tape page 2-1

Basic OPC procedures page 3-1
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References in this document

 

This document refers to the following documents in the AccessNode Northern 
Telecom Publication (NTP) library.

 

Commissioning and Testing, Volume 3

Operations, Administration, and Provisioning, Volume 4A

 

•

 

Network Element User Interface Description

 

, 323-3001-300

•

 

OPC User Interface Description

 

, 323-3001-301

•

 

System Administration Procedures

 

, 323-3001-302
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1-1

 

Managing network element database 

 

backups from NE to OPC 1-

 

The Backup/Restore Manager tool enables you to manage the network element 
(NE) database backup files that the operations controller (OPC) stores 
automatically. You can use these database files to restore data to an NE after it 
is rebooted or after a software release upgrade. 

The OPC makes routine database backups for each NE in its span of control. 
Database backups run under the following criteria:

• once every 24 hours

• after each reboot of an NE 

• after a certain number of changes are recorded

• after the completion of a release upgrade 

You must delete backups that are no longer required. 

If storage is at a premium, be sure to delete backups of old releases. You can 
list all of the backup files that exist and delete backup files that are no longer 
needed.

For further information on the Backup/Restore Manager tool, see 

 

OPC User 
Interface Description

 

, 323-3001-301, in this volume.
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Chapter task list 

 

This chapter includes the following tasks.

If you cannot successfully complete these procedures, contact your next level 
of support.

 

Procedure Task See

 

1-1 Displaying the backups for a network element page 1-3

1-2 Displaying all backups stored on the OPC page 1-4

1-3 Deleting a backup from the OPC page 1-5

1-4 Setting the backup schedule on the NE page 1-7

1-5 Performing a manual NE database backup page 1-10

1-6 Restoring an NE database from the OPC page 1-12
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Procedure 1-1

 

Displaying the backups for a network element 

 

Use this procedure to display the list of backup files currently stored on the 
operations controller (OPC) for a particular network element (NE). 

 

Requirements 

 

To perform this procedure, you must meet the following requirements:

• obtain a userID and password that permit access to the OPC and use the 
Backup/Restore Manager 

• read the command conventions for the interface (CMT or graphical) you 
are using in 

 

OPC User Interface Description

 

, 323-3001-301, in this 
volume

 

Action 

 

Step Action 

1

 

Log in to the OPC and open the Backup/Restore Manager tool. 

 

The Backup/Restore Manager main window appears.

 

2

 

Move to the NE in the list for which you want to see the backup files, then 
press 

 

Ctrl_A

 

 (or Keypad 

 

0

 

). 

 

3

 

Display the list item menu by pressing 

 

Ctrl_L

 

 (or Keypad 

 

Enter

 

). 

 

The list item menu appears. 

 

4

 

Select the Manage backups option by pressing 

 

Space

 

 (or Keypad 

 

0

 

). 

 

The Manage Backups dialog appears, displaying all backups currently stored 
on the OPC for the NE.

 

5

 

To close the dialog, tab to the 

 

Done

 

 button, then press 

 

Ctrl_A

 

 (or Keypad 

 

0

 

). 

 

The dialog closes. 

 

6

 

To close the tool:

 

a.

 

Display the Window menu by pressing 

 

Ctrl_L W

 

 (or Keypad 

 

6

 

). 

 

The Window menu appears. 

 

b.

 

Select the 

 

Exit

 

 command by pressing 

 

Space

 

 (or Keypad 

 

0

 

). 

 

The tool closes. 

 

—end— 
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Procedure 1-2

 

Displaying all backups stored on the OPC 

 

Use this procedure to display a list of all backup files for the network elements 
(NEs) in the operations controller (OPC) span of control. 

 

Requirements 

 

To perform this procedure, you must meet the following requirements: 

• obtain a userID and password that permit access to the OPC and use the 
Backup/Restore Manager 

• read the command conventions for the interface (CMT or graphical) you 
are using in 

 

OPC User Interface Description

 

, 323-3001-301, in this 
volume

 

Action 

 

Step Action 

1

 

Log in to the OPC and open the Backup/Restore Manager tool. 

 

The Backup/Restore Manager main window appears.

 

2

 

Display the Options menu by pressing 

 

Ctrl_L T

 

 (or Keypad

 

,

 

). 

 

The Options menu appears.

 

3

 

Move to the

 

 

 

Query all backups entry option, then press 

 

Space (or Keypad 0). 

The Query All Backups dialog appears.

4 To close the dialog, tab to the Done button, then press Ctrl_A (or Keypad 0). 

The dialog closes. 

5 To close the tool:

a. Display the Window menu by pressing Ctrl_L W (or Keypad 6). 

The Window menu appears.

b. Select the Exit command by pressing Space (or Keypad 0). 

The tool closes. 
—end—
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Procedure 1-3
Deleting a backup from the OPC 

Use this procedure to delete backups for old software releases. To conserve 
disk space, delete backups you no longer need. The OPC only stores up to two 
backups for network elements running the current software release. 

Requirements 
To perform this procedure, you must meet the following requirements: 

• obtain a userID and password that permit access to the OPC and use the 
Backup/Restore Manager 

• read the command conventions for the interface (CMT or graphical) you 
are using in OPC User Interface Description, 323-3001-301, in this 
volume

Action 

Step Action 

1 Log in to the OPC and open the Backup/Restore Manager tool. 

The Backup/Restore Manager main window appears.

2 Display the Options menu by pressing Ctrl_L T (or Keypad,). 

The Options menu appears.

3 Move to the Query all backups option, then press Space (or Keypad 0). 

The Query All Backups dialog appears, showing a list of all backups. 

Note: You can also execute Procedure 1-1 on page 1-3 and delete a backup 
file from the displayed list.

4 Select the backup file you want to delete by pressing Ctrl_A (or Keypad 0). 

The entry is highlighted. 

5 Display the list item menu by pressing Ctrl_L (or Keypad Enter). 

6 Select the Delete backup command by pressing Space (or Keypad 0). 

A dialog appears, asking you to confirm that you want to delete this backup.

7 Tab to the OK button, then press Ctrl_A (or Keypad 0). 

The backup file is deleted and the Delete Backup dialog closes.

8 To close the Query All Backups dialog, tab to the Done button, then press 
Ctrl_A (or Keypad 0). 

The dialog closes.
—continued—
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Procedure 1-3 (continued)   
Deleting a backup from the OPC

Step Action 

9 To close the tool:

a. Display the Window menu by pressing Ctrl_L W (or Keypad 6). 

The Window menu appears.

b. Select the Exit command by pressing Space (or Keypad 0). 

The tool closes. 
—end—
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Procedure 1-4
Setting the backup schedule on the NE 

Use this procedure to set or change the backup schedule for a specific network 
element (NE). A scheduled backup is performed automatically starting on the 
specified day and at the time, continuing at the specified frequency, and ending 
on the specified day and at the time. 

The Schedule Active field indicates whether an event is currently running. For 
example, if the value for the Backup event is an * (asterisk), then a backup is 
currently running. If the value is a. (period), then the event is not currently 
running. 

Shelf database backups are stored at the operations controller (OPC) where up 
to two active backups, labeled “current” and “backup,” can be kept at any one 
time. When a manual or automatic backup is performed, the oldest copy is 
deleted, and the other copies are relabeled accordingly. 

Requirements 
To perform this procedure, you must meet the following requirements:

• have admin-level security clearance

• know what port to display or change and what the parameter values should 
be

Action 

Step Action 

1 From the Network Element Status screen, display the Network Element 
Profile screen by entering: 

admin nep ↵
The Network Element Profile screen appears. 

2 Display the Network Element Schedule screen by entering: 

schedule ↵
The Network Element Schedule screen appears. 

3 Display the screen with the edit schedule menu by entering: 

edit↵
The Edit Schedule menu appears. 

Note: To prevent a scheduled event from occurring, set the end date to 
yesterday.

—continued—
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Procedure 1-4 (continued)
Setting the backup schedule on the NE

Step Action 

4 Set or change any or all of the NE scheduling parameters. If you are setting 
the backup schedule for the first time, set all the parameters as described in 
the following table.

—continued—

If setting Then

frequency Specify how often the backup runs in a given period by 
entering: 

frequency <unit> <time interval> ↵

where

<unit>

<time interval>

2

D day (1 to 730)
H hour (1 to 17543)
M minute (1 to 32767)
S second (60 to 32767)

strttime Specify the time for the backup to start by entering: 

strttime <unit> <hour> <minute>  ↵

where

<unit>

<hour>

<minute>

2

1 to 24; defaults to 00

0 to 59; defaults to 00

strtdate Specify the date for the backup to start by entering: 

strtdate <unit> <day> <month> <year> ↵

where

<unit>

<day>

<month>

<year>

2

1 to 31; defaults to current 
day

1 to 12; defaults to 1

1976 to 2039; defaults to 
1990

—continued—
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Procedure 1-4 (continued)
Setting the backup schedule on the NE

Step Action

5 Return to the Network Element status screen by entering: 

quit 3 ↵
The Network Element Status screen appears. 

—end—

If setting Then

endtime Specify the time for the backup to stop by entering: 

endtime <unit> <hour> <minute> ↵

where

<unit>

<hour>

<minute>

2

1 to 24; defaults to, meaning 
forever

0 to 59; defaults to 0

enddate Specify the date for the backup to stop by entering: 

enddate <unit> <day> <month> <year> ↵

where

<unit>

<day>

<month>

<year>

2

1 to 31; defaults to, meaning 
forever

1 to 12; defaults to 1

1976 to 2039; defaults to 
1990

—end—
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Procedure 1-5
Performing a manual NE database backup 

Use this procedure to make a backup copy of the network element (NE) 
database that includes all the provisioning data. If a failure occurs, you can use 
the backup copy to restore the NE database. A backup is recommended every 
time a provisioning change is made. 

Shelf database backups are stored in the nonvolatile memory of the operations 
controller (OPC) module.

Two copies of the database are stored: current and backup 1. When you 
perform a backup, the oldest copy is deleted. 

Do backups periodically to make sure the backup has the most recent data. 
Running backups periodically minimizes the amount of lost data if a failure 
occurs. If you schedule the backup as a network event, it runs automatically. 
For details see System Administration Procedures, 323-3001-302, in this 
volume. 

Requirements 
To perform this procedure, you must meet the following requirements:

• read the command conventions described in Network Element User 
Interface Description, 323-3001-300, in this volume

• perform this procedure from MAPCI;FWPUI screens

Action 

Step Action

1 From the Network Element Status screen, display the equipment shelf screen 
for the selected NE by entering: 

equipmnt sh ↵
The Shelf Equipment screen appears for the selected NE. 

2 Back up the database by entering: 

backupdb ↵
The system prompts for confirmation. 

3 Confirm the backup command by entering: 

y ↵
The backup process can take up to 5 minutes to complete, depending on 
system use. 

—continued—
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Procedure 1-5 (continued)
Performing a manual NE database backup

Step Action

4 Confirm the backup by checking the logs buffer by entering: 

logutil ↵
open FWDB ↵
The FiberWorld Database (FWDB) logs show the status of the database 
backup and the elapsed time of the backup. An FWDB300-series log 
indicates a problem with the backup. 

—end—
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Procedure 1-6
Restoring an NE database from the OPC

Use this procedure to restore a network element (NE) database (provisioning 
information) from a copy of the database stored in the operations controller 
(OPC). 

For each vintage of software release, the OPC stores two copies of the NE 
database: current and backup1. When you restore a database, specify what 
copy is required. Backup1 is the copy previous to the current copy. 

The restore command used in this procedure logs out all users at the selected 
NE.

Requirements 
To perform this procedure, you must meet the following requirements:

• read the command conventions described in Network Element User 
Interface Description, 323-3001-300, in this volume

• perform the restore NE database procedure from FWPUI screens

Action 

Step Action

1 From the Network Element Status screen, display the equipment shelf screen 
for the selected NE by entering: 

equipmnt sh ↵
The Shelf Equipment screen appears for the selected NE. 

2 Restore the database by entering:

restore ↵
<version> ↵

The system prompts for confirmation. 
—continued—

where

<version> the database version to be restored: current or 
backup1
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Procedure 1-6 (continued)
Restoring an NE database from the OPC

Step Action

3 Confirm the restoration by entering: 

y ↵  

All users are logged out of the selected NE. 
The restoration process can take several minutes to complete. 

Note: The NE requests a database restore from the OPC. If a database is 
available, the download is performed. If the OPC has no copy of the NE 
database for the current software release vintage, or if the OPC copy of the 
database is out of date with respect to the NE, the NE restores the database 
from the NE RAM.

4 Confirm the restoration by checking the logs buffer by entering:

logutil ↵
open FWDB ↵
The FiberWorld Database (FWDB) logs show the status of the database 
restore operation and the elapsed time of the restoration. An 
FWDB300-series log indicates a problem with the operation. 

5 Determine if the database was restored from the OPC.

—end—

If the database was restored Then you have

from the OPC finished this procedure

from the NE RAM to reboot the NE. Contact Nortel 
technical support for advice on how 
to proceed.
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2-1

Backing up files to and restoring from 
tape 2-

The operations controller (OPC) Save and Restore tool allows you to save to 
tape and to restore important network data from tape from a single directory. 
This data includes the following: 

• network element (NE) software loads and databases 

• OPC configuration data and databases 

• UNIX system data 

• user configuration data 

• any product-specific data 

Note: OPC Port 1 (also called Port B) configuration data is not saved to or 
restored from tape. OPC Port 1 is unaffected by any tape operation.

The Save and Restore tool provides three basic functions: 

• First, the main purpose of the tool is to back up data to a tape in the local 
OPC tape drive. 

• Second, the tool restores files to the local OPC from a backup tape if OPC 
data is corrupted or the OPC is replaced. 

• Third, after files are restored from a backup tape, the tool synchronizes the 
local OPC with the backup OPC by transferring the restored files to a 
single directory in the backup OPC. 

For all three operations, the OPC Save and Restore tool automatically selects 
all appropriate files. You cannot select individual files to save, restore, or 
transfer to the backup OPC.

You can use the OPC Save and Restore tool by itself to back up local OPC data 
as a safeguard or with other tools to upgrade software for the local and backup 
OPCs. For the network upgrade procedures for your system, see the network 
upgrade Customer Application Procedure (CAP) for your system. 

For further information on the OPC Save and Restore tool, see the description 
in OPC User Interface Description, 323-3001-301, in this volume.
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Handling and storing digital audio tapes
Keep digital audio tapes (DATs) away from moisture, extreme hot and cold 
temperatures, and magnetic fields and devices. 

When handling DATs around equipment, note that electrostatic-sensitive 
devices can be damaged by electrostatic discharge. Always ground yourself 
before handling the tape. 

Chapter task list 
The following tasks are included in this chapter. They can be performed at any 
time and in any order. 

If you cannot successfully complete these procedures, contact your next level 
of support.

Procedure Tasks See

2-1 Saving OPC data to tape page 2-3

2-2 Scheduling a backup page 2-6

2-3 Restoring OPC data from tape page 2-10

2-4 Transferring OPC data to the backup OPC page 2-14

2-5 Identifying the backup tape page 2-16



Backing up files to and restoring from tape   2-3

AccessNode   Data Administration Procedures   323-3001-304   Issue 1.0

Procedure 2-1
Saving OPC data to tape

Use this procedure to save OPC data to a backup tape in the OPC tape drive. 
After you start the save operation, you cannot access any other OPC tool until 
the operation is canceled or completed. The save operation can take up to 40 
minutes to complete depending on the amount of data on the disk.

You cannot select individual files to be saved. The OPC Save and Restore tool 
automatically selects and saves the appropriate files.

When you open the tool, the “Save to tape” operation is selected by default.

Note: If the Save to tape button at the top of the main window is disabled, 
the local OPC is inactive. You cannot perform the following procedure.

The tool contains two action buttons: 

• Display tape details 

• Save OPC data to tape 

It is recommended that you select both buttons in the order that they appear.

Requirements
To perform this procedure, you must meet the following requirements:

• insert the tape in the local OPC tape drive (use a blank tape, or an existing 
tape designated for commissioning data for this OPC) 

• allow the tape to reach room temperature

Note: Never insert a tape that has been stored at temperatures outside the 
range 10°C to 30°C (50°F to 90°F) until it has reached room temperature.

• have a userID and password that allow you access to the OPC

• connect a terminal to the OPC
—continued—

CAUTION
Risk of damage to electrostatic-sensitive devices
Electrostatic-sensitive devices can be damaged by 
electrostatic discharge. Always ground yourself before 
handling the tape.
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Procedure 2-1 (continued)
Saving OPC data to tape

• log in to the OPC

• read the command conventions described in OPC User Interface 
Description, 323-3001-301, in this volume

Action

Step Action 

1 Open the OPC Save and Restore tool. 

The OPC Save and Restore main window appears. The Save to tape button 
is selected and the buttons for saving OPC data to tape appear in the bottom 
half of the window. 

2 Select the Display tape details button by pressing Ctrl_A (or Keypad 0). 

The Tape Details dialog appears. It shows information about the tape. 

3 Check the fields in the dialog to confirm that the correct tape is in the tape 
drive. 

If you inserted the incorrect tape, remove it and insert the correct one.

4 When the correct tape is in the tape drive, select the Done button in the Tape 
Details dialog by pressing Ctrl_A (or Keypad 0).

The Tape Details dialog closes. In the OPC Save and Restore tool main 
window, the arrow moves to the Save OPC data to tape button.

5 Select the Save OPC data to tape button by pressing Ctrl_A (or Keypad 0). 

The Save confirmation dialog appears, prompting you to confirm your 
request. 

6 Tab to the Yes button, then press Ctrl_A (or Keypad 0). 

If the backup tape is blank, a progress dialog appears, indicating that the save 
operation has been initiated.

Go to step 7.

If the backup tape contains data that you are overwriting, a configuration 
dialog appears.

Go to step 8.

—continued—
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Procedure 2-1 (continued)
Saving OPC data to tape

Step Action

7 Determine whether you want to continue or cancel the save operation.

8 Determine whether the tape contains a data archive or a software load.

If the tape contains a data archive, a dialog prompts you to confirm your 
request to overwrite the existing data on the tape. 

If the tape contains a software load, a dialog prompts you to confirm your 
request to overwrite the existing data on the tape. 

Tab to the OK button, then press Ctrl_A (or Keypad 0). 

A progress dialog appears, indicating the progress of the save operation. 

9 To cancel the save operation, select the Cancel button by pressing Ctrl_A 
(or Keypad 0). 

 A confirmation dialog appears, prompting you to confirm your request to 
cancel the save operation. 

10 Tab to the OK button, then press Ctrl_A (or Keypad 0). 

Another progress dialog appears that indicates the save operation is being 
canceled and the tape is being erased. 

When you cancel the save operation, a completion dialog appears. 

11 To exit the completion dialog, select the Done button by pressing Ctrl_A 
(or Keypad 0). 

The completion dialog closes and the main window appears.

Go to step 12. 

12 To close the tool:

a. Display the window menu by pressing Ctrl_L W (or Keypad 6). 

The window menu appears. 

b. Select the Exit command by pressing Space (or Keypad 0). 

The tool closes.
—end—

If you want to Then go to

cancel the save operation step 9

continue with the save operation step 11 when the completion 
dialog appears

If you want to Then go to 

cancel the save operation step 9

continue with the save operation step 11 when the completion 
dialog appears
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Procedure 2-2
Scheduling a backup

Use this procedure to 

• enable or disable the scheduler

• define a new schedule for backups of operations controller (OPC) data to 
tape

• edit the existing schedule.

You can perform the subtasks of this procedure in various sequences. For 
example, you can edit (redefine) the schedule while the scheduler is enabled or 
disabled. Alternatively, if a backup is imminent, you may want to disable the 
scheduler, edit the schedule, and then enable the scheduler again.

Requirements
To perform this procedure, you must meet the following requirements:

• have a userID and password that permit access to the OPC Save and 
Restore Tool

• read the command conventions for the interface (CMT or graphical) you 
are using in OPC User Interface Description, 323-3001-301, in this 
volume

Action

Step Action

1 Log in to the OPC and open the OPC Save and Restore tool.

The OPC Save and Restore main window appears in save mode. The Save 
to tape button is selected and the buttons for saving OPC data to tape and for 
scheduling a backup appear in the bottom half of the window. 

—continued—

CAUTION
Risk of damage to electrostatic-sensitive devices
Electrostatic-sensitive devices can be damaged by 
electrostatic discharge. Always ground yourself 
before handling the tape.
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Procedure 2-2 (continued)
Scheduling a backup

Step Action

Note: The default state of the scheduler is the disabled state.

Enabling the scheduler

2 Enable the scheduler.

a. Tab to the Enable scheduler button, then press Ctrl_A (or Keypad 0).

A message appears, indicating that the scheduler is enabled and 
reminding you to place a writable tape in the tape drive before the 
scheduled backups begin.

b. Tab to the Done button, then press Ctrl_A (or Keypad 0).

The OPC Save and Restore tool main window appears. The Scheduler 
State label now reads, “Scheduler is enabled” and the label on the Enable 
scheduler button has changed to “Disable scheduler”.

Go to step 7.

Defining a new schedule or editing an existing schedule

3 To define a new schedule or to edit the existing schedule, tab to the Edit 
schedule button, then press Ctrl_A (or Keypad 0).

The backup schedule dialog appears.

—continued—

If you want to Then go to

enable the scheduler step 2

define a new schedule or edit the existing schedule of 
backups

step 3

disable the scheduler step 6

close the OPC Save and Restore tool step 7

If you want to Then 

use the default schedule The default settings schedule backups to 
occur every day at 04:00, starting tomorrow. 
To use the default schedule, tab to the 
Default button, then press Ctrl_A 
(or Keypad 0).

The Run every field is set to 1. The day(s) 
button is selected. The Next run fields are set 
to 04:00 and tomorrow’s date.

Go to step 5.

—continued—
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Procedure 2-2 (continued)
Scheduling a backup

Step Action

4 Define the time the backups are to occur and the date the backups are to 
begin.

a. Tab to the Next run fields.

b. Enter the time you want the backups to occur, using the format, hh:mm, 
where hh is the hour and mm is the minutes.

Note: For the time to be valid, use the 24-hour clock convention. Enter a 
colon (:) between the hour and the minutes.

c. Enter the date when you want the next backup to occur. The only valid 
dates are today’s date and tomorrow’s date. The following methods for 
entering dates are available:

• You can enter the date directly into the field, using the format 
mm/dd/yyyy, where mm is the month, dd is the day and yyyy is the 
year.

• You can display the chooser menu by pressing Ctrl_L / (or Keypad 3) 
and select Today, then press Ctrl_A (or Keypad 0). The date is 
automatically entered in the field.

• You can display the chooser menu by pressing Ctrl_L / (or Keypad 3) 
and select Tomorrow, then press Ctrl_A (or Keypad 0). The date is 
automatically entered in the field.

Note: For the date to be valid, you must enter the forward slash (/) between 
the day, month, and year (as in 01/31/1997).

5 Schedule the backups to occur according to the entries in the Backup 
Schedule dialog. Tab to the OK button, then press Ctrl_A (or Keypad 0).

The OPC Save and Restore tool main window appears. 
—continued—

If you want to Then 

define a schedule or edit an 
existing schedule

Define the frequency of the backups.

a. Tab to the Run every field and enter how 
often you want the backups to occur. The 
valid range of values for the Run every 
field depends on which Time button you 
plan to select in step b.

If you select hours, the valid range of 
values is 2 to 23; if you select days, the 
valid range of values is 1 to 99.

b. Tab to the Time buttons and use the arrow 
keys to move to the button you want to 
select (hour(s) or day(s)). Press Ctrl_A (or 
Keypad 0).

—end—
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Procedure 2-2 (continued)
Scheduling a backup

Step Action

Note: If a scheduled save operation is currently in progress, you cannot edit 
the schedule information. You must wait until the save operation is complete. 
If you edit the schedule information during a backup and select the OK button, 
an error message appears.

Select the Cancel button to close the Backup Schedule dialog without 
changing the original information and display the OPC Save and Restore tool 
main window.

Disabling the scheduler

6 To disable the scheduler, tab to the Disable scheduler button, then press 
Ctrl_A (or Keypad 0).

The scheduled backups cannot occur again until the scheduler is enabled. 
The Scheduler State label now reads “Scheduler is disabled” and the label on 
the Disable scheduler button is “Enable scheduler”.

Closing the tool

7 To close the tool:

a. Display the window menu by pressing Ctrl_L W (or Keypad 6). 

The window menu appears. 

b. Select the Exit command by pressing Space (or Keypad 0). 

The tool closes.
—end—

If you want to Then go to

enable the scheduler step 2

disable the scheduler step 6 

close the OPC Save and Restore tool step 7 
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Procedure 2-3 
Restoring OPC data from tape 

Use this procedure to retrieve data from a backup tape to the operations 
controller (OPC) disk. This procedure overwrites all existing data on the OPC 
disk. 

That is, if the network element (NE) configuration data on the backup tape is 
different from the data on the OPC disk, performing this procedure will 
transfer the old data on the backup tape to the OPC disk, overwriting all 
existing data on the disk. All files are saved to a single directory.

This procedure contains two operations:

• displaying the tape name so that you know you are using the correct tape

• restoring data from a tape

In addition, it is recommended that you transfer OPC data to the backup OPC 
after you restore data from a backup tape. See Procedure 2-4 on page 2-14.

This procedure can take more than 40 minutes to complete. Once the restore 
operation begins, you cannot cancel the operation or use any other OPC tool 
until the operation is complete. During the restore operation, the local OPC is 
taken out of service and all current OPC operations are interrupted. At the end 
of the restore operation, a reboot occurs.

—continued—

CAUTION
Risk of damage to electrostatic-sensitive devices
Electrostatic-sensitive devices can be damaged by 
electrostatic discharge. Always ground yourself before 
handling the tape.

CAUTION
Risk of network outage
If the restore operation fails, be sure the appropriate NE 
loads remain on the OPC using the OPC Reboot/Load 
Manager tool. If the NE loads are corrupted, you must 
attempt to restore the loads as quickly as possible or 
transfer the standby OPC to duty. If you leave the loads off 
the duty OPC and an NE requires a reboot, no load is 
available a network outage can occur.
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Procedure 2-3 (continued)
Restoring OPC data from tape

This procedure overwrites existing data on the local OPC. Overwriting the 
existing data affects any OPC tools that use this data. For example, restoring 
OPC data on the local OPC can cause inaccurate download statistics in the 
Reboot/Load Manager tool. 

Note: Be aware that inconsistencies between the OPC and NE database can 
be introduced after performing the restore operation. A mismatch between 
the NE and the OPC can occur since the data from the OPC database is 
based on the last save operation.

Requirements 
To perform this procedure, you must meet the following requirements:

• allow the tape to reach room temperature 

Note: Never insert a tape that has been stored at temperatures outside the 
range 10°C to 30°C (50°F to 90°F) until it has reached room temperature.

• insert the backup tape in the local OPC tape drive 

• have a userID and password that permit access to the OPC 

• read the command conventions for the interface (CMT or graphical) you 
are using in OPC User Interface Description, 323-3001-301, in this 
volume

Action 

Step Action 

1 Log in to the OPC and open the OPC Save and Restore tool. 

The OPC Save and Restore main window appears in save mode. The Save 
to tape button is selected and the buttons for saving OPC data to tape appear 
in the bottom half of the window. 

2 Tab to the Save to tape button at the top of the main window. Do not select it. 

3 Using the down arrow key, move to the Restore from tape button, then press 
Ctrl_A (or Keypad 0). 

The buttons for restoring OPC data from tape appear in the main window. 

Note: If a backup OPC exists, a Transfer data to Backup OPC button appears.

4 To confirm that the correct tape is in the tape drive, select the Display tape 
details button by pressing Ctrl_A (or Keypad 0). 

—continued—
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Procedure 2-3 (continued)
Restoring OPC data from tape

Step Action

After an In progress message appears, the Tape Details dialog appears, 
displaying information about the tape. If you do not have a tape inserted, 
“unknown” appears in the Tape type field.

5 Check the fields in the Tape Details dialog to confirm that the correct tape is 
in the tape drive. 

6 To remove the Tape Details dialog, select the Done button by pressing Ctrl_A 
(or Keypad 0). 

The Tape Details dialog closes. In the main window, the arrow moves to the 
Restore OPC data from tape button. 

7 In the main window, select the Restore OPC data from tape button by 
pressing Ctrl_A (or Keypad 0). 

A confirmation dialog appears, prompting you to confirm your request. 

8 Tab to the Yes button, then press Ctrl_A (or Keypad 0). 

The confirmation dialog closes. Several In progress messages appear in 
succession showing the progress of the tape extraction. During this period the 
local OPC becomes inactive. A dialog appears, indicating that the OPC is out 
of service.

9 To remove the information dialog, select the Done button by pressing Ctrl_A 
(or Keypad 0).

The out-of-service dialog closes. A dialog appears, indicating the progress of 
the restore operation. 

Note: The restore operation can take up to 40 minutes to complete. When the 
OPC is active again, an information dialog appears for each user session. 

10 To remove the information dialog, select the Done button by pressing Ctrl_A 
(or Keypad 0). 

The information dialog closes. A completion dialog appears, indicating that 
the restore operation is complete. 

11 To remove the completion dialog, select the Done button by pressing Ctrl_A 
(or Keypad 0). 

The completion dialog closes. An In progress message appears indicating 
the OPC Shutdown tool is being opened. The OPC Shutdown tool appears.

12 Select the Shutdown button by pressing Ctrl_A (or Keypad 0).

A warning dialog appears.

13 Tab to the Proceed button, then press Ctrl_A (or Keypad 0).

An information dialog appears.

14 Select the OK button by pressing Ctrl_A (or Keypad 0).

An information dialog appears indicating the OPC is shutting down.
—continued—
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Procedure 2-3 (continued)
Restoring OPC data from tape

Step Action

15 Select the OK button by pressing Ctrl_A (or Keypad 0).

An In progress message appears followed by the Out of service dialog.

16 Select the Done button by pressing Ctrl_A (or Keypad 0).

The dialog closes. A reboot occurs.

Note 1: It is recommended that you transfer OPC data to the backup OPC 
after you restore data from the backup tape. See Procedure 2-4 on 
page 2-14.

Note 2: If after you perform this procedure, NEs need to be recovered or the 
alarm “Database not restored. Type Q approve at NE.” needs to be cleared, 
then perform “Restoring an NE database from the OPC” on page 1-12.

—end—
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Procedure 2-4 
Transferring OPC data to the backup OPC

Use this procedure to transfer operations controller (OPC) data from the local 
OPC disk to the backup OPC. This procedure can take up to 30 minutes to 
complete. You can transfer data from an active OPC only. 

It is recommended that you transfer OPC data to the backup OPC after you 
restore data from a backup tape. You can use the following procedure at any 
time to synchronize the local OPC with the backup OPC. 

Requirements 
To perform this procedure, you must meet the following requirements:

• have a userID and password that permit access to the OPC 

• read the command conventions for the interface (CMT or graphical) you 
are using in OPC User Interface Description, 323-3001-301, in this 
volume

Action 

Step Action

1 Log in to the OPC and open the OPC Save and Restore tool. 

The OPC Save and Restore main window appears. The Save to tape button 
is selected and the buttons for saving OPC data to tape appear in the bottom 
half of the window. 

2 Tab to the Save to tape button at the top of the main window. Do not select it. 

3 Using the down arrow key, move to the Restore from tape button, then press 
Ctrl_A (or Keypad 0). 

The buttons for restoring OPC data from tape appear in the main window. 

4 Tab to the Transfer data to Backup OPC button, then press Ctrl_A (or 
Keypad 0). 

Note 1: If the local OPC is not the primary OPC and you are performing this 
procedure from the backup OPC, the name of the button is “Transfer data to 
primary OPC”. 

Note 2:  You cannot perform this procedure if your system does not have a 
backup OPC. That is, the “Transfer data to backup OPC” button in does not 
appear in the main window. 

A confirmation dialog appears, prompting you to confirm your request. 
—continued—
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Procedure 2-4 (continued)
Transferring OPC data to the backup OPC

Step Action

5 Tab to the Yes button, then press Ctrl_A (or Keypad 0). 

The confirmation dialog closes. Progress dialogs appear, indicating that the 
data on the OPC disk is being copied to the backup OPC. 

Note: This operation can take up to 30 minutes to complete. 

When the transfer is complete, the following completion dialog appears. 

6 To remove the dialog, select the Done button by pressing Ctrl_A 
(or Keypad 0). 

The dialog closes. 

7 To close the tool: 

a. Display the window menu by pressing Ctrl_L W (or Keypad 6). 

 The window menu appears. 

b. Select the Exit command by pressing Space (or Keypad 0). 

 The tool closes. 
—end—
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Procedure 2-5   
Identifying the backup tape 

Use this procedure to confirm that the correct tape is in the local operations 
controller (OPC) tape drive. This procedure displays a dialog with a series of 
fields that give general information about the backup tape. The fields describe 
the tape, the span of control that the tape is created for, and the OPC software 
load that created the tape. You cannot make changes to this dialog. 

It is recommended that you display this dialog before you save or restore OPC 
data. Because of this recommendation, this procedure is included as part of 
Procedure 2-1 on page 2-3 and Procedure 2-3 on page 2-10. However, you can 
use this procedure, without the other two procedures, to confirm the contents 
of a backup tape. 

Requirements 
To perform this procedure, you must meet the following requirements: 

• insert the backup tape in the local OPC tape drive 

• have a userID and password that allow you access to the OPC 

• read the command conventions for the type of interface you are using 
(CMT or graphical) in OPC User Interface Description, 323-3001-301, in 
this volume

Action 

Step Action 

1 Log in to the OPC and open the OPC Save and Restore tool. 

The OPC Save and Restore main window appears. The Save to tape button 
is selected and the buttons for saving OPC data to tape appear in the bottom 
half of the window. 

2 Select the Display tape details button by pressing Ctrl_A (or Keypad 0). 

The Tape Details dialog appears, displaying information about the tape. 

3 To exit the Tape Details dialog, select the Done button by pressing Ctrl_A 
(or Keypad 0). 

The Tape Details dialog closes. 

4 To close the tool: 

a. Display the window menu by pressing Ctrl_L W (or Keypad 6). 

The window menu appears. 

b. Select the Exit command by pressing Space (or Keypad 0). 

The tool closes. 
—end—
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3-1

Basic OPC procedures 3-
This chapter contains common operations controller (OPC) procedures. Use 
these procedures as required during testing, or when they are referenced in 
other procedures.

Chapter task list
This chapter includes the following tasks.

If you cannot successfully complete these procedures, contact your next level 
of support.

Procedure Task See

3-1 Shutting down an OPC page 3-2

3-2 Checking the OPC tape identification page 3-5

3-3 Transferring data between OPCs page 3-7
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Procedure 3-1
Shutting down an OPC

Use this procedure to shut down or reboot an operations controller (OPC). 

The procedure is the same for restarting or halting. If you restart the OPC, the 
OPC shuts down and immediately restarts. If you want to remove all power 
from the OPC so that it can be removed from the shelf, use the halt option.

Requirements
To perform this procedure, you must meet the following requirements:

• have a userID and password of a user that has permission to shut down the 
OPC. Only users in the root, slat, or admin class can shut down the active 
OPC. Users in the root or standby class can shut down the inactive OPC. 

• connect a terminal to the OPC that you want to shut down or reboot

• log in to the OPC

Action

Step Action 

1 Login to the OPC and open the OPC Shutdown tool. 

The OPC Shutdown tool main window appears. 

2 Select the Shutdown button by pressing Ctrl_A (or Keypad 0). 

A confirmation dialog appears, indicating the amount of time required for the 
shutdown and giving you a final chance to abort the shutdown.

3 Select the Cancel button by pressing Ctrl_A (or Keypad 0). 

The OPC Shutdown tool main window appears.

4 To close the tool:

a. Display the window menu by pressing Ctrl_L W (or Keypad 6). 

The window menu appears. 

b. Select the Exit command by pressing Space (or Keypad 0). 

 The tool closes. 

5 Tab to the Proceed button, then press Ctrl_A (or Keypad 0). This step 
commits the tool to shut down the OPC.

—continued—

If you want to Then go to 

abort the OPC shutdown step 3

proceed with the OPC shutdown step 5
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Procedure 3-1 (continued)
Shutting down an OPC

Step Action

The confirmation dialog closes and the OPC shutdown process starts. A 
console message appears. 

6 Select the OK button by pressing Ctrl_A (or Keypad 0). 

A shutdown progress dialog appears. As the shutdown progresses, the dots 
on the dialog are replaced with Xs. 

The progress dialog indicates that the OPC is shutting down normally. If the 
shutdown completes before you select the OK button, you will not see the 
progress message.

An “out of service” dialog appears when the shutdown is complete. This 
dialog appears to all users who are currently logged in to the OPC.

7 Select the Done button by pressing Ctrl_A (or Keypad 0). 

An information dialog appears.

8 Depending on the task you are performing, you might be required to remove 
the OPC module from its shelf or to power down a portable OPC. In these 
cases, you must take the required action before the OPC attempts to reboot. 

Determine now if you will be powering down a portable OPC or removing an 
OPC. 

9 Tab to the Restart button, then press Ctrl_A (or Keypad 0). 

The OPC reboots without delay after the shutdown completes. If you select 
this option, you do not have time to physically remove the OPC without 
damaging the OPC. 

10 Tab back to the OK button, then press Ctrl_A (or Keypad 0). 

The shutdown procedure completes. The OPC then initiates a reboot, which 
takes 5–10 minutes. When it is complete, the OPC login prompt (login:) 
appears. 

The shutdown terminates all user login sessions. You have to log in again 
after the OPC returns to service. 

You must not remove or power down the OPC during the reboot process. 

11 Select the OK button by pressing Ctrl_A (or Keypad 0). 

The shutdown procedure continues. When it is complete, the green Activity 
Indicator LED turns off. 

—continued—

If you will be Then go to

allowing the OPC to start up step 9

removing or powering down the OPC step 11
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Procedure 3-1 (continued)
Shutting down an OPC

Step Action

12 Immediately after the green LED turns off, remove the OPC or power down 
the portable OPC. 

To power down a portable OPC:

a. Change the power switch at the back of the portable OPC to the OFF 
position when the shutdown dialog indicates you should

b. Remove the CNET cable from both the network element and the portable 
OPC. (For more information, see the procedure for connecting the 
portable OPC to the network in OPC User Interface Description, 
323-3001-301, in this volume.)

If the OPC is still in place or if the portable OPC is powered up 3 minutes after 
the LED turns off, a start up is initiated. If you have not removed or powered 
down the OPC by this time, the red Unit Fail LED turns on and an alarm is 
raised. 

When the reboot procedure is complete, the OPC login prompt (login:) 
appears. The shutdown terminates all user login sessions. You have to log in 
again after the OPC returns to service. 

—end—

CAUTION
Risk of data corruption
Do not remove or power down the OPC after the red LED 
is on. If you do, you will corrupt the data on its hard drive. 
The shutdown process takes 5 to 10 minutes. 
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Procedure 3-2   
Checking the OPC tape identification

Use this procedure to confirm that the correct tape is in the operations 
controller (OPC) tape drive or to determine the data that is on a particular tape. 

Requirements
To perform this procedure, you must meet the following requirements:

• allow the tape to reach room temperature

Note: Never insert a tape that has been stored at temperatures outside the 
range 10°C to 30°C (50°F to 90°F) until it has reached room temperature.

• have a userID and password that allow you access to the OPC

• connect a terminal to the OPC

• log in to the OPC

• insert the tape in the OPC tape drive

Action

Step Action 

1 Open the OPC Save and Restore tool. 

The OPC Save and Restore main window appears. The Save to tape button 
is selected and the buttons for saving OPC data to tape appear in the bottom 
half of the window. 

2 Select the Display tape details button by pressing Ctrl_A (or Keypad 0). 

The Tape Details dialog appears. It shows information about the tape. 

3 Check the fields in the dialog to confirm the correct tape is in the tape drive. 

If the tape has never been used, the “Tape type” is “Unknown” and all other 
fields are blank.

You cannot change the information in this dialog. This information is written to 
this dialog by the OPC when tape is used to record the backup data from the 
OPC.

4 If you inserted the wrong tape, remove the tape and insert the correct one.

5 To exit the Tape Details dialog, select the Done button by pressing Ctrl_A (or 
Keypad 0). 

The Tape Details dialog closes.
—continued—
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Procedure 3-2 (continued)
Checking the OPC tape identification

Step Action

6 Now determine:

7 To close the tool:

a. Display the window menu by pressing Ctrl_L W (or Keypad 6). 

The window menu appears. 

b. Select the Exit command by pressing Space (or Keypad 0). 

The tool closes.
—end—

If you want to Then go to

overwrite the data on the tape Procedure 2-3

restore data from the tape to an OPC Procedure 2-3

remove the tape and close the tool step 7
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Procedure 3-3
Transferring data between OPCs

Use this procedure to transfer operations controller (OPC) data from the disk 
of one OPC in a span of control to any other OPC in the same span of control. 

You can use this procedure to transfer data

• from the backup OPC to the primary OPC

• from the primary OPC to the backup OPC

You can also use this procedure to transfer the commissioning data from a 
portable OPC to the primary or backup OPC.

This procedure can take up to 30 minutes to complete. You can transfer data 
from an active OPC only. 

It is recommended that you transfer OPC data to the backup OPC after you 
have restored data from a backup tape. You can use the following procedure at 
any time to synchronize the data in the primary and backup OPCs. 

Requirements
To perform this procedure, you must meet the following requirements:

• have a userID and password that allow you access to the OPC

• connect a terminal to the OPC that has the good data

• read the command conventions for the interface (CMT or graphical) you 
are using in OPC User Interface Description, 323-3001-301, in this 
volume

Action

Step Action

1 Log in to the OPC that contains the network data that you want to save and 
open the OPC Save and Restore tool.

The OPC Save and Restore main window appears. The Save to tape button 
is selected and the buttons for saving OPC data to tape appear in the bottom 
half of the window. 

2 Tab to the Save to tape button at the top of the main window. Do not select it. 

3 Using the down arrow key, move to the Restore from tape button, then press 
Ctrl_A (or Keypad 0). 

The buttons for restoring OPC data from tape appears in the main window. 
—continued—
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Procedure 3-3 (continued) 
Transferring data between OPCs

Step Action 

4 Tab to the Transfer data to Backup OPC button, then press Ctrl_A (or 
Keypad 0). 

If you are transferring data from the backup or portable OPC to the primary 
OPC, this button reads “Transfer data to Primary OPC”.

A confirmation dialog appears, prompting you to confirm your request. 

5 Tab to the Yes button, then press Ctrl_A (or Keypad 0). 

The confirmation dialog closes and a progress dialog appears, indicating that 
the data on the OPC disk is being copied to the other OPC. 

Note: This operation can take up to 30 minutes to complete. 

When the transfer is complete, a completion dialog appears. 

6 To exit from the dialog, select the Done button by pressing Ctrl_A (or 
Keypad 0). 

The dialog closes. 

7 To close the tool:

a. Display the window menu by pressing Ctrl_L W (or Keypad 6). 

The window menu appears. 

b. Select the Exit command by pressing Space (or Keypad 0).

The tool closes.
—end—
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